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Preface

This documentation describes the Configuration Utility which is used to modify global and local
configuration files and to create or modify parameter files.

This documentation is organized under the following headings:

Starting and Terminating the
Configuration Utility

How to start and terminate the Configuration Ultility.

Elements of the Configuration Utility
Window

General information on the menu bar, toolbar, parameters, context
menus and status bar.

Working with the Configuration Utility

How to locate and change parameters, find parameters, and save
changes. How to create, copy, paste, rename, delete, export and
import parameter files, and how to use help.

Overview of Configuration File
Parameters

Information on the parameters that can be set in the global and
local configuration files. In this section you will also find
information on the buffer pool assignments.

Overview of Profile Parameters

Information on the profile parameters that can be set in the
parameter files.

Invoking Natural with an Alternative
Parameter File

How to invoke Natural Studio and Natural Runtime with your
own customized parameter file.

See also: Profile Parameter Usage in the Operations documentation and Parameter Reference.

This utility is used to set the parameters in a Windows environment. If you are using Natural for
Windows for remote development in conjunction with Natural's Single Point of Development
(SPoD), see also the sections referring to parameter usage in the corresponding platform-specific

Operations documentation.

] Notes:

1. Parameter files are upward-compatible, but not downward-compatible. Once you have created
a parameter file in a higher version of the Configuration Utility and you try to read it with a
lower version, an error message will be displayed. To be able to read the file, export the file to
the higher version and then import this file to the lower version of the Configuration Utility.

2. Parameter files are not compatible on different platforms. Therefore, it is not possible to copy
them from one platform to another (for example, from Windows to UNIX or OpenVMS). If you
want to use a parameter file on a different platform, export the file and then import this file on

the target platform.




vi
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at https://documenta-
tion.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
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About this Documentation

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give
us a call.

Software AG Tech Community

You can find documentation and other technical information on the Software AG Tech Community
website at https://techcommunity.softwareag.com. You can:

" Access product documentation, if you have Tech Community credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest.
" Access articles, code samples, demos, and tutorials.

= Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Starting and Terminating the Configuration Utility

Starting the Configuration Utility

A Natural folder automatically appears in the Programs folder of the Start menu after Natural
has been installed. It contains the shortcuts for Natural, including the Natural Configuration
Utility and Help. Several shortcuts are also available on your Windows desktop.

~ To start the Configuration Utility

s From the Windows Start menu, choose All Programs > Software AG > Administration >
Natural Configuration Utility n. n.

| Note: The Start menu group name (by default, this is "Software AG") can be changed
during the installation.

The Natural Configuration Utility window appears. See Elements of the Configuration
Utility Window for further information.

Terminating the Configuration Utility

When you terminate the Configuration Utility and you have not yet saved your changes, a dialog
appears for each changed file asking whether you want to save now.

~ To terminate the Configuration Utility

s From the File menu, choose Exit.
Or:
Press ALT+F4.
Or:
From the Control menu, choose Close.
Or:

Choose the corresponding standard button at the right of the title bar.
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Starting and Terminating the Configuration Utility

Performing a Function while Starting the Configuration Utility

You can perform several functions automatically when starting the Configuration Utility.

Create a shortcut on your desktop for starting the Configuration Utility and invoke the properties
of the shortcut. You can then specify the following functions after natparm.exe in the Target text
box.

Function Description

exit Terminates the Configuration Utility.
import=parameter-file Imports the specified parameter file.
export=parameter-file Exports the specified parameter file.
parm=parameter-file Selects the specified parameter file in the tree.
save Saves a parameter file.
save=new-parameter-file-name |Saves a parameter file under a different name.

Multiple functions can be specified one after the other (see the examples below).
Examples

* Invoke the Configuration Utility and select the specified parameter file in the tree so that it can
be edited immediately:

natparm.exe parm=parameter-file

® Invoke the Configuration Utility, select the specified parameter file in the tree, and save it as a
new file with the specified name:

natparm.exe parm=parameter-file save=new-parameter-file-name

® Invoke the Configuration Utility, load and export the specified parameter file and terminate the
Configuration Utility:

natparm.exe parm=parameter-file export=parameter-file exit

* Invoke the Configuration Utility, import the specified parameter file and save it under the name
of the imported file:

natparm.exe import=parameter-file save

Configuration Utility 7
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Elements of the Configuration Utility Window

When you start the Configuration Utility, the name of the parameter file which is currently active
is shown in the title bar. It is also selected in the tree.

File Edit View Help

DUEE B X 2|

= Matural Configuration Files

Matural Configuration Ltiliby

[ Global Configuration File
i [ Local Configuration File
El Matural Parameter Files

28 NATPARM

&1 NDVPARM

- NWODEMO

- SYSLOAD

Menu Bar

The following menus are available:

Menu |Using the commands in this menu, you can ...

File |Manage (for example, create or delete) parameter files and save the change to all parameter and
configuration files.

Edit |Copy and paste parameter files, and search for parameters.

View |Show or hide the toolbar and status bar.

Help |Invoke the online documentation and display information about the Configuration Utility.

Many commands can also be chosen from a toolbar and/or context menu.
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Elements of the Configuration Utility Window

Toolbar

You can execute the most important functions using a toolbar button. When you move the mouse
pointer over a toolbar, a brief description for the button is shown in the status bar.

The following toolbar buttons are available:

[ Create new parameter file

Save selected parameter or configuration file
Save all files

Copy selected parameter file

Paste copied parameter file

X @ F B O

Delete selected parameter file

%, Restore last saved version of selected parameter or configuration file

@ Display help

The drop-down list box in the toolbar enables you to search for a specific parameter. See Finding
a Parameter.

~ To switch the toolbar display on and off

s From the View menu, choose Toolbar.

A check mark is shown next to this menu command when the toolbar is displayed in the
Configuration Utility window.

Tree

The tree on the left side of the Configuration Utility window contains nodes for two different types
of files:

® Natural Configuration Files

When you expand this node, you can modify global and local configuration files. See Overview
of Configuration File Parameters.
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Elements of the Configuration Utility Window

® Natural Parameter Files

When you expand this node, you can modify the profile parameters of the different parameter

files. See Overview of Profile Parameters.

For information on how to change the parameter assignments and on how to create your own
parameter files, see Working with the Configuration Utility.

Parameters

When you select a node for a category in the tree, the parameters are shown on the right of the
window. In case of a parameter file, the names of the Natural profile parameters are shown in
parenthesis on the right of the window, behind the label of the corresponding control. Example:

==l | Matural C ui
File Edit View Help

DEHE | BR| X 2| 2|

-

=1 NATPARM

-- Database Management

- Natural Execution Configuration
- Batch Mode

- Buffer Sizes

FCnrecier Assignmens
-Command Execution

- Date Representation

- Device/Report Assignments
-Error Handling

-Field Appearance

-Limits

-Program Loading and Deletion
-Regional Settings

-Report Parameters

-Steplibs

- System Files

m

Character Assignments |

Terminal command character
Clear key

Dedmal character

Filler character

Help character

Input assign

Input delimiter

Thousands separator character (THSEPCH)

cF)
(CLEAR)
{c)
FC)
{HI)
(1A}
{10}

Ready

12
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Elements of the Configuration Utility Window

Context Menus

Context menus provide for selection the commands that are valid in the current context. The
content of a context menu depends on the currently selected node in the Configuration Utility
window.

> To invoke a context menu

1  Select the node for which you want to invoke a context menu.

2 Click the right mouse button.

The context menu appears and you can now choose the required command.

Status Bar

The status bar is the horizontal information line at the bottom of the Configuration Utility window.
It shows short help texts for the commands in the menu bar, toolbar and context menu.

~ To switch the status bar display on and off

s From the View menu, choose Status Bar.

A check mark is shown next to this menu command when the status bar is displayed in the
Configuration Utility window.

Configuration Utility 13
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Working with the Configuration Utility
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= Using Help
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Working with the Configuration Utility

Creating a New Parameter File

You can create your own parameter files and customize them to your requirements. You can then
invoke Natural with one of these parameter files. See Invoking Natural with an Alternative
Parameter File for further information.

Initially, each parameter file that you create contains Natural's default settings.

@

Tip: It is recommended that you create your own parameter file instead of modifying the
default parameter file NATPARM which is delivered with Natural.

~ To create a new parameter file

1

J

From the File menu, choose New.
Or:

Choose the following toolbar button:

O

Or:
Press CTRL+N.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter automat-
ically deletes the selection.

Enter a name for the new parameter file.

Press ENTER.
Or:
Click any other position in the tree.

The parameters in the new file are set to the default values. You can set all parameters as re-
quired.

Note: You can also create a new parameter file by copying an existing file or by saving an

existing file under a new name.

16

Configuration Utility



Working with the Configuration Utility

Locating and Changing a Parameter

You can locate a parameter in different ways:
® If you know in which parameter group and category the parameter can be found, you can expand
the tree and locate the parameter as described below.

= If you do not know the parameter group and category, you can search for the parameter. See
Finding a Parameter.

~ To locate and change a parameter

1  Expand the node for a global or local configuration file or for a specific parameter file.

2 For parameter files: expand the node for a parameter group (for example, Natural Execution
Configuration).

3 Select the category containing the parameter that you want to change (for example, Buffer
Sizes).

The parameters are shown on the right of the window. In the case of a parameter file, the
names of the Natural profile parameters are shown in parenthesis on the right of the window,
behind the label of the corresponding control.

Or:
Expand the node for a category.

Descriptions for the parameters are shown in the tree, below the node. When you select a
description in the tree, all parameters for this group are shown on the right of the window.
For the description that has been selected in the tree, the corresponding parameter is also se-
lected on the right of the window and can be modified immediately.

4  Set the parameter to the required value. See Overview of Configuration File Parameters or

Overview of Profile Parameters for further information.

] Notes:

1. The following applies for check boxes: when a check box is selected, the corresponding
parameter is set to "ON"; when a check box is not selected, the corresponding parameter
is set to "OFF".

2. A browse button, which shows three dots, is available for several parameters. When you
choose this button, you can select the required setting(s) in a dialog box.

When a parameter has been changed, an asterisk (*) appears next to the corresponding node
name in the tree.
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Working with the Configuration Utility

5 Save your changes as described in Saving the Changes.

Finding a Parameter

If you do not know in which category a parameter can be found, you can search for it. The search
is always performed in the currently selected parameter file, global configuration file or local
configuration file.

~ To find a parameter

1  Select a node which belongs to the parameter file or configuration file in which you want to
search for the parameter.

2 From the Edit menu, choose Find.
Or:
Press CTRL+F.

When the toolbar is currently not shown, it is automatically activated and the drop-down list
box containing the parameters is opened.

| Note: When the toolbar is already visible, you can simply open the drop-down list box,

without having to use the above command.

3 Select the parameter from the drop-down list box in the toolbar.

| Note: When a configuration file is currently selected, you can select a category (for ex-

ample, Printer Profiles which belongs to the global configuration file) from the drop-
down list box.

The category containing the selected parameter is shown on the right of the window.

Saving the Changes

Different save commands are available. An asterisk (*) appears next to each node name in the tree
where a parameter has been changed.

~ To save the changes for the selected configuration file or parameter file

1  Select the node for the file that you want to save.

2 From the File menu, choose Save.
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Working with the Configuration Utility

Or:

Choose the following toolbar button:

=]
Or:

Press CTRL+S.

~ To save a parameter file under a different name

1  Select the node for the parameter file that you want to save under a different name.

2 From the File menu, choose Save As.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter deletes
the selection automatically.

3 Enter a name for the new parameter file.

4  Press ENTER.

Or:

Click any other position in the tree.
~ To save the changes to all files

s From the File menu, choose Save All.
Or:

Choose the following toolbar button:
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Working with the Configuration Utility

Restoring the Last Saved Version

It is possible to discard your changes and return to the last saved version.

~ To return to the last saved version of the selected configuration file or parameter file

1  Select the node for the file for which you want to discard your changes.

2 From the File menu, choose Restore Saved.
Or:

Choose the following toolbar button:
%

The settings of the last saved version are restored.

Copying and Pasting a Parameter File

You can also create a new parameter file by copying an existing file and pasting it in the tree.

~ To create a new parameter file

1 Select the node for the parameter file that you want to copy.

2 From the Edit menu, choose Copy.
Or:

Choose the following toolbar button:

Or:

Press CTRL+C.

3  From the Edit menu, choose Paste.
Or:

Choose the following toolbar button:

20
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Working with the Configuration Utility

Or:
Press CTRL+V.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter automat-
ically deletes the selection.

4  Enter a name for the new parameter file.

5  Press ENTER.
Or:
Click any other position in the tree.

You can now set all parameters as required.

Renaming a Parameter File

You can rename the parameter files in the tree.

When you invoke Natural with a parameter file that has been renamed, make sure to changed its
name in the corresponding shortcuts. See Invoking Natural with an Alternative Parameter File
for further information.

~ To rename a parameter file

1 Select the node for the parameter file that you want to rename.
2 From the File menu, choose Rename.
Or:

Press F2.

The name is selected so that you can immediately enter a new name. Any text you enter
automatically deletes the selection.

3 Enter a new name for the parameter file.

4  Press ENTER.
Or:

Click any other position in the tree.
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Working with the Configuration Utility

Deleting a Parameter File

You can delete the parameter files in the tree.

When you invoke Natural with a parameter file that has been deleted, make sure to adapt the
corresponding shortcuts. See Invoking Natural with an Alternative Parameter File for further
information.

~ To delete a parameter file

1  Select the node for the parameter file that you want to delete.

2 From the File menu, choose Delete.
Or:

Choose the following toolbar button:

X
Or:

Press DEL.

Exporting a Parameter File

When you export a parameter file, a text file is generated which contains the values of the current
parameter file. Such a text file can be used on Windows, UNIX and OpenVMS platforms; to use
it there, you have to import it.

~ To export a parameter file

1 Select the node for the parameter file that you want to export.

2 From the File menu, choose Export.
The Export dialog box appears. The name of the selected parameter file is proposed as the
file name. The extension of the resulting file is "LST".

3  Optional. Specify another file name. You can also select another folder.

4 Choose the Save button to export the file.

If you have not selected another folder, the file is stored in the Natural folder which has been
defined for the temporary files. See also Installation Assignments.
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Working with the Configuration Utility

Importing a Parameter File

You can import a parameter file which has previously been exported. The import generates a
binary parameter file from the text file with the extension "LST" which has been generated during
the export.

~ To import a parameter file

1

From the File menu, choose Import.

The Import dialog box appears.
Select the file that is to be imported. The extension of such a file is "LST".
Choose the Open button.

When a file with the same name does not yet exist, the imported parameter file is shown in
the tree.

When a file with the same name already exists, you are asked whether you want to overwrite
the existing file. When you choose not to overwrite the existing file, the new file is created
with the name "NEWn".

Using Help

The Help menu provides different ways of accessing help for the Configuration Utility.

~ To access the Configuration Utility documentation

From the Help menu, choose Help Contents.
Or:

Choose the following toolbar button:

®

~ To invoke context-sensitive help

1
2

Select the node or parameter for which you want to invoke context-sensitive help.

From the Help menu, choose Context Help.
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Working with the Configuration Utility

Or:
Press Fi.
> To display information about the Configuration Utility

s From the Help menu, choose About Natural Configuration Utility.

A dialog box appears, displaying information such as the current version number.
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Overview of Configuration File Parameters

This chapter provides information on the parameters that can be set in the global and local config-
uration files.

File Edit View Help

O M@

= Matural Configuration Files

(- Glebal Configuration File

-- Database Management System Assignments

Matural Corfiguration Litiliby

-- Dictionary Server Assignments
-- Printer Profiles
[~ Systern Files

E| Local Cenfiguraticn File

-- Buffer Pool Assignments
[ Installation Assignments
f- Watural Parameter Files

The configuration files should only be modified by an administrator. They should only be changed
with the Configuration Utility.

Global Configuration File

This parameter group contains the following categories:

= Database Management System Assignments
= Dictionary Server Assignments

= Printer Profiles

= System Files

Database Management System Assignments

The parameters which apply to the database management system assignments are arranged on
the following pages:

= DBMS Assignments
= DBMS Tracing
= SQL Assignments
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Overview of Configuration File Parameters

= XML Assignments

DBMS Assignments

A table is shown which is used to define the database ID with which the database is mapped in

the DDM.

When DBMS assignments have already been defined, they are shown in the table.

DBID
The database ID.

] Note: If you are using DDMs where the database ID is set to "0", a separate entry where
the database ID is also set to "0" must exist, with the corresponding database type spe-
cified. This entry is used at compilation time in order to generate the corresponding
database statements into the generated program (GP).

Type

Since the types of all databases which are to be accessed by Natural must be defined in the
global configuration file, specify one of the following values for each database ID:

Value

Description

ADA/ADA2 | Adabas database server (this is the default).

See also Adabas Database Management Interfaces ADA and ADA?2 in the Programming Guide.

SQL Any SQL database that can be accessed using Entire Access, which is Software AG's
common interface to various SQL database systems.
XML Tamino database server.

A

Important: You must not define a database type for a DBID which has already been as-
signed to a system file in the global configuration file (see System Files). If you do so,

an error message will be issued at Natural startup, indicating an inconsistency in the

system file setting and an error when reading the database assignments.

At compilation time, the profile parameter UDB is not used to determine the database type. UDB
is only used at runtime to determine the database type. The database types must be the same
at compilation time and at runtime.

Parameter
Applies only to databases of the following types:
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Overview of Configuration File Parameters

Type

Description

ADA/ADA2

If your database type is ADA or ADA2, you can choose between two access methods:

= If you leave the parameter string empty, the classic access method via ADALNK is
used. This is the default.

= Alternatively, you can specify an ADATCP connect string here, instructing Natural to
connect to Adabas via TCP/IP.

See Natural and Adabas Access in the Database Management System Interfaces documentation
for further information

SQL

If your database type is SQL, specify the string (DBMS parameter) that is to be used to
establish the connection to the database system with which you want to work. See Natural
and Entire Access in the Database Management System Interfaces documentation for further
information on how to access SQL-type database systems.

XML

If your database system is XML (Tamino), enter the URL of the Tamino database including
the name of the collection which is to be accessed in this database. See Natural for Tamino
in the Database Management System Interfaces documentation for further information on
how to access Tamino databases.

DBMS Tracing

The settings for Adabas Trace, SQL Trace and XML Trace are for error diagnostics reasons. They
should only be filled out when requested by Software AG support. Software AG support will
provide valid values in this case.

SQL Assignments

The following tables are provided:

" SQL date/time conversion
This table is used to specify the conversion masks for Entire Access.

As Natural has only one specific time format, you must decide how this format should be inter-
preted in the context of SQL database access. There are several possibilities, however, there is
only one possibility per SQL-type DBID which can be specified here.

DBID

Cannot be edited. Entries for the SQL-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Mask

The value specifies the configuration for Entire Access. It also specifies the format used to
retrieve the SQL information for DATE, TIME and DATETIME into fields of Natural data format
A. The mask should match the RDBMS-specific configuration for the DATE, TIME or DATETIME
character string representation.
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Date
This mask (usually a sub-string of the Mas k value) specifies the character string representation
into which the fields of Natural data format D are converted during update or retrieval of
SQL DATE columns.

Time
This mask (usually a sub-string of the Mas k value) specifies the character string representation
into which the fields of Natural data format T are converted during update or retrieval of
SQL TIME or DATETIME columns.

Remark
You can enter your remarks here, for example, to document how the SQL DATE and TIME
character string representation is configured on the database site.

For database systems that support a common data type both for date and for time, the hash
character (#) can be used in the mask to skip non-relevant portions of DATETIME strings. For ex-
ample, the following settings of the masks may be appropriate for the Microsoft SQL Server
which supports a common DATETIME data type for date and time values:

Mask = YYYYMMDD HH:II:SS
Date = YYYYMMDD
Time = JHHHHHHHHIHH:TT:SS

" SQL authorization
This table is used to specify user IDs and passwords for an automatic login to an SQL database.

DBID
Cannot be edited. Entries for the SQL-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Auto Login
When the check box in this column is selected, a non-interactive login is performed to the
database by using the values from this table row. Furthermore, the evaluations of the envir-
onment variables SQL_DATABASE_LOGIN, SQL_DATABASE_USER, SQL_DATABASE_PASSWORD,
SQL_OS_USER and SQL_0S_PASSWORD are suppressed.

Type
To define the kind of authentication to be performed for this DBID, specify one of the follow-
ing values:

Value  |Description

DB Database authentication.

(01 Operating system authentication.

DB_OS |Both, database authentication and operating system authentication.

Please note that it depends on the database system which kind of authentication is available.
Furthermore, there are restrictions concerning operating system authentication in Entire
Access. See the Entire Access documentation for a more detailed description.
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DB User
The user ID for database authentication.

DB Password
The password for database authentication.

OS User
The user ID for operating system authentication.

OS Password
The password for operating system authentication.

XML Assignments

A table is shown which is used to specify user IDs and passwords for an automatic login to a
Tamino database.

DBID
Cannot be edited. Entries for the XML-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Auto Login
When the check box in this column is selected, a non-interactive login is performed to the
database by using the values from this table row. Furthermore, the evaluations of the environ-
ment variables XML_DB_USER, XML_DB_PASSWORD, XML_HTTP_USER and XML_HTTP_PASSWORD are
suppressed.

DB User
The user ID for Tamino database authentication.

DB Password
The password for Tamino database authentication.

HTTP User
The user ID for web server authentication.

HTTP Password
The password for web server authentication.

Dictionary Server Assignments

With dictionary servers, you can access free rules and automatic rules maintained in Predict once
you have access to Predict on a mainframe or UNIX host.

| Note: A dictionary server (also referred to as Predict server) can be any Natural RPC server

running in the same environment that Predict is installed in.

You can assign so-called dictionary servers (a free rule server and an automatic rule server) to one
common logical server name. It is possible to define more than one logical server name where
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each name represents a different pair of free rule server and automatic rule server. The servers to
be assigned can be located on different nodes.

In the global configuration file, you define all dictionary servers that are available for selection in
the parameter file. The name of the logical server that is to be used must then be defined in the
parameter file. See Remote Dictionary Access in the Overview of Profile Parameters.

You can specify the following information:

Name
Specify the name for a logical dictionary server. You can then specify the required information
for the free rule server and automatic rule server in the corresponding text boxes (see below).

When you select the name of a previously defined a logical dictionary server from this drop-
down list box, the text boxes for the free rule server and automatic rule server show the previ-
ously defined information for this logical dictionary server. You can modify or delete this as-
signment.

Free rule server
Specify the server name and node name for the server that is to be used for remote access to
Predict free rules.

Automatic rule server
Specity the server name and node name for the server that is to be used for remote access to
Predict automatic rules.

Printer Profiles

Printer profiles are used for printing additional reports, for hardcopies and for batch output gen-
eration. They recognize particular Natural field attributes and insert the appropriate control se-
quences (see below) as defined in the profile.

With the ability to translate Natural field attributes into escape sequences, you can control your
printer in various ways by using the right profile name, and you can use the print features of a
given device by using simple attributes in Natural programs.

Each profile that you define can be assigned to a Natural report number either statically by using
the Configuration Utility (see Device/Report Assignments), or dynamically by using the DEFINE
PRINTER statement within a Natural program.

The parameters which apply to the printer profiles are arranged on the following pages:

= Printer Profiles
= TTY Printer Profiles

Configuration Utility 31



Overview of Configuration File Parameters

= GUI Printer Profiles
Printer Profiles

You can specify the following information:

Name
The name of the printer profile.

Method
You can choose the button in this column to toggle the print method for this printer profile.

Method [ Description

TTY |Print data (text files) are sent directly to the spooler “as is”. Any printer command sequences
need to be specified explicitly, either dynamically (as program data) or statically (via a printer
profile). As such, the application has full control over the command sequences. This is a low-level
print method that by-passes the printer driver. If you want to use this method, you have to
specify all required information on the TTY Printer Profiles page.

GUI |Report data (page descriptions) are passed to the printer driver which converts the report data
into a spool file, together with any necessary printer control sequences, in the appropriate form
(PostScript, PCL, etc.). This is the normal way of printing under Windows. If you want to use

this method, you have to specify all required information on the GUI Printer Profiles page.

TTY Printer Profiles

You can specify the following information:

Profile name
This drop-down list box contains all TTY-type profile names that have been defined on the
Printer Profiles page. Select the name of the required profile. All information that you specify
on this page, applies to the currently selected profile.

External character set
Optional. An external character set must be defined, for example, if a printer's character set is
different from the system character set, or if you wish to preserve Unicode data by outputting
the data in UTF-8 format.

You can specify the name of the external character set. If the name is "UTF-8", the data are
converted into UTF-8 format. Otherwise, any name can be used, but it must agree with the
name used in the character translation table definition in the file NATCONV.INI. For example,
if the internal character set name (as defined near the top of the NATCONV.INI file) is
"ISO8859_1" and you define "FRED" as the name of the external character set in the printer
profile, a section with the following name must be defined in the file NATCONV.INI, otherwise
no character translation is performed:
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[IS08859_1 -> FRED]

Note that, in the non-UTEF-8 case, the data are first converted from the in-memory format (UTF-
16) into the system code page, prior to any NATCONV.INI-based translation being applied.

For further information on the NATCONV.INI file, see Support of Different Character Sets with
NATCONVINI in the Operations documentation.

Printer control sequences

You can specify whether commands to be triggered at job, page or field level.

Column |Description

Trigger | A triggering event controls the level on which specified printer control sequences are to be
applied. Each row in this scrollable table applies to a specific triggering event:

JOB

Use this triggering event if you want your control sequences to apply
to an entire print job. The specified control sequences will represent
the job header and/or job trailer respectively.

PAGE

Use this triggering event if you want the control sequences to apply
to each physical output page. The specified control sequences will then
represent the page headers and/or page trailers respectively.

FIELD

Use this triggering event if you want the control sequences to apply
to each field (regardless of its AD, CD or PM attributes).

AD and CD

These triggering events stand for specific attributes of the session
parameters AD (attribute definition) and CD (color definition). Use these
triggering events if you want the control sequences to be applied at
field level only. Any field in a Natural program with corresponding
attributes will then cause these control sequences to take effect. See
the Parameter Reference for details on these session parameters.

PM=I

Use this triggering event if you want the control sequences to apply
to each field with an opposing print direction to that of the page. See
the session parameter PM (print mode) and the terminal command %V
(control of print mode) for more information.

Leading|The leading control sequence is inserted immediately before the triggering event (for example,
to define a job header or to set attributes for field representation).

Trailing | The trailing control sequence is inserted immediately after the triggering event (for example,
to define a job trailer or to reset attributes previously set).

For each control sequence, you can specify the control characters in either alphanumeric or

hexadecimal format.

] Notes:

1. Blank characters must always be specified in hexadecimal format (*20). If they were entered
directly, they would be confused with the blanks used to delimit tokens in the configuration

file.

Configuration Utility

33



Overview of Configuration File Parameters

2. The escape character must always be specified in hexadecimal format (*1b) because this is
a non-printable character.

Example

This example shows the PCL command for setting a proportional character spacing in both
alphanumeric and hexadecimal format. The escape character "*1b", which must always be
specified in hexadecimal format, corresponds to the decimal value 27.

Alphanumeric format:
Ab(s1P

Hexadecimal format:

A [pR2827 3231250
GUI Printer Profiles

You can specify the following information:

Profile name
This drop-down list box contains all GUI-type profile names that have been defined on the
Printer Profiles page. Select the name of the required profile. All information that you specify
on this page, applies to the currently selected profile.

Margins
The page margins. You can specify (in points) an extra top, bottom, left and/or right page
margin, relative to the top left-hand corner of the printable region.

Text color
The color to be used. You can select one of the following values:

Value |Description

Leave |Leave the color setting unspecified (a default setting is used).

Ignore |Ignore any color settings (that is, print everything in black).

Retain |Retain any color settings in your Natural program (as specified with the session parameter CD).

Attribute fonts
Fonts are always associated with a particular field representation attribute of the session
parameter AD. You can define a different font for each attribute.

The following options are available:
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Option Description

Display fonts for|Using this drop-down list box, you determine which fonts that are to be shown in
the Font dialog box (which appears when you choose a Set button; see below). If
you select System, only the screen fonts are shown. When you select one of the
printers, any fonts that are installed on this printer are shown in addition to the
screen fonts; this gives you access to more fonts, but has the disadvantage of making
the profile printer-specific.

Fixed fonts only |When this check box is selected, only fixed fonts are shown in the Font dialog box
(which appears when you choose a Set button; see below). When it is not selected,
all fonts (fixed fonts and proportional fonts) are shown in the Font dialog box.

Extra leading You can specify (in points) an extra vertical line spacing in addition to the default
line spacing.

AD When you choose the Set button for an attribute, the Font dialog box appears. This
is a standard Windows dialog in which you can define a font, font style and size.
When a Clear button is enabled, a font has been defined for the corresponding
attribute; you can choose this button to remove the font definition.

System Files

A list of existing Natural system file assignments is shown.

The paths for all possible system files (that is: for all possible DBID/FNR combinations) are defined
in the global configuration file. These must be valid paths which indicate the physical location of
the system files on the disk.

You can specify the following information:

DBID
The database ID.

FNR
The file number.

Alias name
When you specify an alias name for a system file, this name is shown in Natural Studio's library
workspace.

Path
The path to the system file.

The path to each defined system file is then available for selection in the parameter file. See System
Files in the Overview of Profile Parameters.
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Local Configuration File

This parameter group contains the following categories:

= Buffer Pool Assignments
= |nstallation Assignments

Buffer Pool Assignments

A table is shown which is used to define buffer pools. See also Natural Buffer Pool in the Operations
documentation.

| Note: When parameters are changed, it is strongly recommended to restart the buffer pool,

as a new session might not be able to connect to the buffer pool otherwise.
You can specify the following information:

BP Name
The name of the Natural buffer pool. The name can be up to 8 characters long. The name of
the default buffer pool is NATBP. See also BP1D in the Parameter Reference.

@  Caution: Do not delete the default buffer pool NATBP, as it is possible that Natural may

not function properly anymore.

BP Size
The size of the Natural local buffer pool. This setting is used during startup of the Natural
buffer pool by the NATBPSRV server to create a global shared memory segment of the specified
size.

Possible settings: 1 - 1024 MB.

Default setting for additional buffer pools: 1.

Resource Size
The size limit for resources that are loaded into the buffer pool. Resources that exceed this size
are loaded directly from the file system whenever they are accessed by Natural. This option
prevents the buffer pool from being filled with big resources. If 0 (zero) is specified, all resources
are loaded into the buffer pool regardless of their sizes.

Possible settings: 1 - buffer pool size in KB.

Default setting: 0.

36 Configuration Utility



Overview of Configuration File Parameters

Maximum Users
The maximum number of users that can have simultaneous access to the buffer pool. This

number determines the sizes of some internal tables stored inside the shared memory during
startup.

Possible settings: 1 - 5000.

Default setting: 20.

Directory Entries
The number of directory entries. This value is used by the NATBPSRV server during the start of
the buffer pool. If the maximum value has been reached, this value is automatically increased.

In case of a read-only buffer pool this value can be ignored because the number of directory
entries is calculated on the basis of the preload list when the buffer pool is started.

Possible settings: 10 - 999999.

Default setting: 10.

Synchronize

You can choose the button in this column to toggle the setting for the buffer pool synchroniz-
ation.

Setting | Description

Yes |Enable synchronization.

No |Disable synchronization (default).

For further information, see Multiple Buffer Pools in the Operations documentation.

Read Only

When this check box is selected, this is a special buffer pool which only allows read access. In
this case, the value for the semaphore key is ignored.

For further information, see Read-Only Buffer Pool in the Operations documentation.

Alternate BP Name

For a read-only buffer pool, it is possible to define the name of an alternate buffer pool. The
alternate buffer pool must also be a read-only buffer pool.

This text box is only active when the corresponding buffer pool is defined as a read-only buffer
pool. In addition, at least two buffer pools must be defined as read-only buffer pools; otherwise
it is not possible to select an alternate buffer pool from the drop-down list box.

For further information, see Alternate Buffer Pool in the Operations documentation.

Configuration Utility 37



Overview of Configuration File Parameters

Installation Assignments

You can specify the following:

Path to parameter

The location of the Natural parameter files.

Path to user profiles

The location of the Natural user profiles.

Global configuration file

The name and location of the global configuration file (default name is NATCONF.CFG).

Natural error file directory

The location of the Natural error files.

Natural I/O conversion table

The name of the file which contains the character translation tables used with the internal
character set ISO-8859-1. By default, this file is called NATCONV.INI. See Support of Different
Character Sets with NATCONVINI in the Operations documentation for further information.

Natural TMP directory

The location of Natural temporary output.

Instead of defining a specific path (for example: c:\ Softwaer AG\ Natural \ temp), you can define
an environment variable (for example: 4usertemp%=mytempdir) and embed this variable in the
path (for example: c:\ SoftwareAG\ Natural\ %ousertemp%). At runtime, the path will be used
with the currently valid environment variable (for example: c:\ Natural \mytempdir\).

A\  Important: You cannot use user environment variables when installing Natural fixes

with the Software AG Update Manager. Only system variables are possible. Please refer
to Special Considerations When Installing Fixes with the Update Manager for further details.

User-defined libraries

The location of user-defined Natural libraries.

Instead of defining a specific path (for example: c:\ SoftwareAG\ Natural \ <userid>\1ib \ <mylib>),
you can define an environment variable (for example: Zuser1ib%=<userid>\1ib\<my1ib>)
and embed this variable in the path (for example: c:\ SoftwareAG\ Natural\ %userlib%). At
runtime, the path will be used with the currently valid environment variable (for example:
c:\Natural \mylibdir).

/\,  Important: You cannot use user environment variables when installing Natural fixes

with the Software AG Update Manager. Only system variables are possible. Please refer
to Special Considerations When Installing Fixes with the Update Manager for further details.

. Note: If you want to specify several libraries, you have to separate the names with a

semicolon, for example userlib1;userlib2;userlib3.
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This chapter provides information on the profile parameters that can be set in the NATPARM para-

meter file (or an alternative parameter file).

File

O

Ready

Edit  “iew Help

"I IERAK]

'?ETJ Matural Configuration Utility [Release Build Daterlul 24 2017 21:45:18 (Rew.:035464)] - NATPARM

[=]lE ]

- Database Managerment
;--General Pararmeters
a;--.éldabas Specific
;--ﬁldministratorDBMSAssignment
i--UserDBMSAssignment

—J- Matural Execution Configuration
;--Batch Mode

;--Buf'fer Sizes
;--Character.&.ssignments
;--Cnmmand Execution
;--Date Representation
a;--Device!Repnr‘t.&.ssignments
;--ErrorHandIing

;--Field Appearance

- Limnits

+ Prograrm Loading and Deletion
+ Regional Settings

+ Report Pararmeters

+- Steplibs

+ Systern Files

+ Systern Wariables

+1.- Work Files

—I- Matural Developrment Environrment
;--CompilerOptions
i--EditnrOptions

—I- Product Configuration

+ Entire Systern Server

- Wieh IFO Interface

—J- Client/Server

- DCOM

+ HTTP Parameters

+ Rernote Dictionary Access
- Remote Procedure Call

—- Taals
;--Debugger
;--Profiler
o Cade Cowverage

m

Matural Configuration Utility
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When you expand the node for a parameter file, nodes for parameter groups are shown.

For a full description of all available profile parameters, see the Parameter Reference.
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Database Management

This parameter group contains the following categories:

= General Parameters

= Adabas Specific

= Administrator DBMS Assignment
= User DBMS Assignment

See also: Database Management System Assignments in the global configuration file.

General Parameters

The following profile parameters apply to the supported database management systems.

Otion See the Parameter Reference for a description of this profile
parameter
Database Updating DBUPD
Execution of END/BACKOUT TRANSACTION | ET
ET at End of Program ETEOP
ET upon Terminal I/O ETIO
Adabas Specific

If Natural is used with Adabas, review the following profile parameters and, if necessary, adjust
the default values to meet your specific requirements.

Option See the Parameter Reference for a description of this
profile parameter

Adabas Review Support ADAPRM

Adabas User Identification ETID

DB Time Limit LDB

Multifetch MFSET

Multifetch Buffer Size MFBS

Multifetch Max Records MFMR

Terminate when no ISN found with FIND statement |RCFIND

Terminate when no ISN found with GET statement |RCGET

Release ISNs RI

Record Hold Processing WH
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Option
. See the Parameter Reference for a description of this
profile parameter
Adabas OPEN/CLOSE Processing OPRB

Administrator DBMS Assignment

The following profile parameters are used to assign administrator-specific database management
system settings.

Opti
pRen See the Parameter Reference for a description of this profile parameter

Administrator Logical Files | LFILE

Translation of File Number |TF

User DBMS Assignment

The following profile parameters are used to assign user-specific database management system
settings.

Option
P See the Parameter Reference for a description of this profile parameter

User Database ID UDB
Database for Transaction Data |[ETDB

User Logical Files LFILE

Natural Execution Configuration

This parameter group contains the following categories:

= Batch Mode

= Buffer Sizes

= Character Assignments

= Command Execution

= Date Representation

= Device/Report Assignments
= Error Handling

= Field Appearance

= | imits

= Program Loading and Deletion
= Regional Settings

= Report Parameters
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= Steplibs

= System Files

= System Variables
= Work Files

Batch Mode

The profile parameters which affect the batch mode behavior of Natural are arranged on the fol-
lowing pages:

= Channels
= Appearance
® Frame Characters

See also Natural in Batch Mode in the Operations documentation.

Channels
Option e . .
See the Parameter Reference for a description of this profile parameter
Input data file name CMOBJIN
Input data code page CPOBJIN

Input commands file name [CMSYNIN

Input commands code page|CPSYNIN

Output file name CMPRINT
Output code page CPPRINT
Natural log NATLOG
Enable error processing cC
Appearance
Option e : .
See the Parameter Reference for a description of this profile parameter
Similar output BMSIM
Display input data ECHO

Display session-end message |[ENDMSG
Display trailing blanks BMBLANK
Display control characters  |BMCONTROL

Display process time BMTIME
Display window title BMTITLE
Display Natural version BMVERSION
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Frame Characters

Option
P See the Parameter Reference for a description of this profile parameter

Frame characters|BMFRAME

Buffer Sizes

Natural uses several buffer areas for the storage of programs and data. You may need to adjust
their sizes in order to achieve maximum buffer efficiency.

Opti
pon See the Parameter Reference for a description of this profile parameter

Storage for sort program SORTSIZE

Source area size SSIZE
Work area size USTZE
SAG editor buffer pool size |[EDTBPSIZE
SAG editor logical files EDTLFILES

See also Buffer Pool Assignments in the local configuration file.
Character Assignments

The following profile parameters are used to change default character assignments.

Option
Y See the Parameter Reference for a description of this profile parameter

Terminal command character |CF

Clear key character CLEAR
Decimal character DC
Filler character FC
Help character HI
Input assign character IA
Input delimiter character ID

Thousands separator character| THSEPCH

Once a character has been defined to replace a default character, this character cannot be used as
data.
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Command Execution

The following profile parameters are used to control the execution of commands.

Option
. See the Parameter Reference for a description of this profile parameter
Enable command mode CM
Enable terminal command %% and % |ESCAPE
Disable Natural commands NC
Dynamic recataloging RECAT

Date Representation

The following profile parameters are used to control the representation of dates.

Option See the Parameter Reference for a description of this profile parameter
Date format in output DFOUT

Date format in STACK DFSTACK

Date format in report titles| DFTITLE

Date format DTFORM

Maximum year MAXYEAR

Year sliding window YSLW

Device/Report Assignments

These parameters are used to modify your screen and printer configurations as well as your report

assignments.

Option

See the Parameter Reference for a description of this profile parameter

Override default report number

MAINPR

Devices

See Device Assignments below.

Reports

See Report Assignments below.

See also the profile parameter CMPRTnn which is used for additional reports in batch mode.

Configuration Utility
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Device Assignments

The Devices group shows a scrollable list of configurable logical devices (VIDEO and the logical
printers LPT1 to LPT31) as used in the DEFINE PRINTER statement. The following information can

be changed:

Method
The button

s in this column display the print method used for the corresponding print device.

You can choose a button to toggle the print methods.

Print Method

Description

TTY

This is the raw printing method where the text output by the Natural program is essentially
forwarded to the spooler in unaltered form. Any printer commands must either be output
as data by the Natural program or statically defined in TTY printer profiles. The Windows
printer driver is not used.

GUI

This is the preferred print method under Windows, whereby the output from the Natural
program is passed through the Windows printer driver associated with the specified
printer. Unlike the TTY method, no knowledge of printer commands is required, since
these are automatically inserted by the printer driver.

Close mode

You can select a different close mode for each logical printer. Possible values in the drop-down

list box are

Close Mode

Description

Auto

Printers are automatically closed at the end of a program or when the execution of a called
method is terminated. This is the default setting.

User

Closing of printers is controlled by the user. The printer is closed, if one of the following
conditions is met:

® 3 CLOSE PRINTER statement is executed,
B a DEFINE PRINTER statement is executed,

= the session terminates.

The following program example describes the user-controlled closing of printers. Note that
the close mode must be first set in the parameter file.

DEFINE DA
LOCAL
1 frouT
END-DEFIN

*

JOUT := *
*

* Write t
WRITE (1)

TA

(A8)
E

PROGRAM

0 report with close mode "user
"OUTPUT PROGRAM: ' #OUT
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*

* Write to report with close mode "auto"
WRITE (2) 'OUTPUT PROGRAM: ' #0UT

*

* Close printer 1
* Printer 1 is user-controlled
CLOSE PRINTER (1)

*

END

Line Size

See the description of the LS parameter.

Page Size

See the description of the PS parameter.

Max. Pages

See the description of the MP parameter.

Setup

You can choose a button in this column invoke a print method-specific dialog box:

Print
Method

Description

TTY

When you choose the Setup button for this print method, the Setup TTY dialog box appears
in which you can specify the following options:

Physical specification
This corresponds to the printer name. Instead of selecting an existing physical printer

specification from the drop-down list box, you can also enter a file name if you want
your output to be written to a file.

Note: A server printer can be specified via the UNC naming convention
(\ \'server-name\ printer-name).
Print to file
Using this check box, you can specify whether file I/O is to be used to access the specified

device (e.g. for printers which are set up as file system shares). If this check box is not
selected, the data is output via spooler API function calls.

GUI

When you choose the Setup button for this print method, the standard Windows Print Setup
dialog box appears and you can select the Windows printer and associated print options
such as page size and orientation.

Note: If you wish to make use of the default Windows printer on each client computer at

run-time, this dialog should not be used. Alternatively, if a specific printer has already been
chosen (even in a previous session) for this logical device, the default printer can be implicitly
re-selected by switching the print method to TTY, closing the application, re-opening the
application and switching the print method back to GUI. Note that any print options for the
default printer must be set by using a printer profile.
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. Note: The following applies to the print method TTY if the Print to file check box has been

activated. As with work files, a file name can be defined by using environment variables.
Any existing file of the same name at the specified location is normally overwritten, unless
the entered file name is immediately prefixed by two right angle bracket characters (>>).

Report Assignments

The Reports group shows a scrollable list in which you can assign a Natural report number (report
1 to report 31) to a logical device name. The following information can be changed:

Device

For each report number, you can select another output medium. Possible values in the drop-
down list box are:

Value Description

LPT1 to LPT31|Outputs the report data to the corresponding physical device.

SOURCE Outputs the report data to the source area. The user can then, for example, issue the
EDIT command to open the output data in the editor and save it accordingly.

DUMMY Report data are discarded.

INFOLINE Report data are sent to the infoline. See also the description of the terminal command

BX.

Report 0 is always implicitly assigned to VIDEO (that is, the output is shown on the screen). No
other report number can be assigned to VIDEO.

Profile
In addition to the name of the logical device, you can assign a printer profile that has been
defined in the Printer Profiles node of the global configuration file. All defined printer profiles
can be selected from the drop-down list box. Select the blank entry if you do not want to use
any of these profiles.

/) Important: Any specified printer profile must match the print method used at run-time.

For example, if an attempt is made to use a GUI printer profile for a TTY logical device
(or vice versa), the printer profile specification is ignored.

Error Handling

The following profile parameters are used to control error handling within Natural.
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Option See the Parameter Reference for a description of this profile parameter
Error processing for PA/PF keys IKEY

Display system error messages in full |MSGSF

Automatic REINPUT REINP

Sound terminal alarm SA

Sound bell on syntax error SNAT

Zero division ZD

Suppress message number prefix NAT

NOAPPLERR

Allow runtime interrupt

RTINT

Field Appearance

The following profile parameters influence I/O handling.

Option
P See the Parameter Reference for a description of this profile parameter
Control variable modified at input [CYMIN
Filler chars protected FCDP
Enable lowercase LC
Overwriting protected 0PF
Zero printing ZP
Print mode PM
Limits

The following profile parameters are used to prevent a single program from consuming an excessive

amount of internal resources.

Option See the Parameter Reference for a description of this profile parameter
Error on loop limit LE

Processing loop limit LT

Maximum number of DBMS calls |[MADIO

Maximum number of program calls [MAXCL

System time delay SD

Configuration Utility
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Program Loading and Deletion

The following profile parameters are used to control the dynamic loading and deletion of programs.

Option L .
See the Parameter Reference for a description of this
profile parameter

Dynamic loading of non-Natural programs CDYNAM

Allow dynamic parameter DYNPARM

Release GDA in utility mode FREEGDA

Session termination on initialization error ITERM

Persistent parameter module PERSIST

Read only access to system files ROSY

Buffer pool search first BPSFI

Error transaction program name ETA

Program command line parameter PRGPAR

Program to receive control after Natural termination|PROGRAM

Natural stack command line STACK

Regional Settings

The following profile parameters are used to control the country- or region-specific settings of
Natural.

Option See the Parameter Reference for a description of this profile parameter
Day differential DD

Time differential D

Year differential YD

User language ULANG

Use UTF-8 format for sources|SUTF8

Retain source format SRETAIN

Code page conversion error |CPCVERR

Default code page CP

Substitution character SUBCHAR
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Report Parameters

The following profile parameters are used to control various attributes of Natural reports.

Option See the Parameter Reference for a description of this profile parameter
Page eject EJ

Numeric edit mask free mode |[EMFM

Line size LS

Page size PS

Spacing factor SF

Default input terminal mode |IM

Steplibs

The following parameters are used to manage the steplibs.

Option
P See the Parameter Reference for a description of this profile parameter

*STEPLIB STEPLIB

Steplib Extension |For information on how to define additional steplibs and how to use the columns in
this table, see Additional Steplib Assignments below.

Additional Steplib Assignments

You can define up to eight libraries that can be searched for objects which cannot be found in the
current library. These additional steplibs are defined in a table. The steplib number is shown in
the first column. The following information can be specified:

Name
The name of an existing library.

DBID
The database ID of the file system where the library is located.

FNR
The file number of the file system where the library is located.

| Notes:
1. The following application programming interfaces are available for handling multiple steplibs:

USR3025N (when Natural Security is not installed) and USR4025N (when Natural Security is in-
stalled).
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2. When Natural is started and the DBID and FNR are set to 0, the default settings from FNAT or
FUSER are used. When the library name starts with SYS but is not SYSTEM, the FNAT is set.
Otherwise the FUSER is set.

System Files
The following profile parameters are used to specify the Natural system files. A page is provided

for each parameter, on which you can specify DBID, FNR, path, read only access, password and
cipher for each system file.

Option
P See the Parameter Reference for a description of this profile

parameter

FNAT (Natural system file for system programs) | FNAT

FUSER (Natural system file for user programs) [FUSER

FSEC (Natural Security system file) FSEC
FDIC (Predict system file) FDIC
FDDM (Natural system file for DDMs) FDDM

If you select a path that has already been assigned to another system file, all relevant internal in-
formation of the first assignment is copied automatically to the new assignment.

The physical location of each system file is defined in the global configuration file. See System
Files in the global configuration file.

System Variables

The following profile parameters are used to adjust Natural system variables for the start of a
Natural session.

Option
P See the Parameter Reference for a description of this profile parameter

Automatic logon|AUTO
Startup library |INIT-LIB

Startup program |STARTUP
User ID USER

See also the System Variables documentation.

| Note: You can use the command line parameter PARM to specify a specific Natural parameter

file at session startup. This parameter can only be specified dynamically, therefore, it cannot
be modified or viewed within the Configuration Utility.

52 Configuration Utility



Overview of Profile Parameters

Work Files

The following profile parameters can be used to specify work file settings.

Option
. See the Parameter Reference for a description of this profile parameter

Entire Connection local NCF protocol [NCFVERS

Max. work file number WORK

Alternate sort work file names TMPSORTUNIQ

Work file open on first access WFOPFA

Work files For information on how to define work files and how to use the

columns in this table, see Work File Assignments below.

See also the profile parameter CMWRKnn which applies to batch mode.

See also Work Files in the Operations documentation.
Work File Assignments

The work file assignments are shown in a scrollable list containing work files with the numbers
1 to 32. The work file number is shown in the first column. When a work file name has already
been defined for a work file number, this information (path and name) is shown in the Name
column.

The following information can be changed:

Type
For each work file number, you can select another work file type. Possible values in the drop-
down list box are:

Work File Type |Description

Default Determines the file type from the extension for upward compatibility.
SAG Binary format.
ASCII Text files with records terminated by a carriage return and linefeed (CR/LF).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.
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Work File Type

Description

ASCII
compressed

ASCII format where all trailing blanks are removed.

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

Entire
Connection

With this work file type, you can read and write (for example, with the statements READ
WORK FILEand WRITE WORK FILE)directly to a work file in Entire Connection format
on the local disk.

Note: No transfer to a PC is possible. The Entire Connection terminal is not used in

this process.

Unformatted

A completely unformatted file. No formatting information is written (neither for fields
nor for records).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

Portable

Files which can handle dynamic variables exactly and can also be transported (for
example, from a little endian machine to a big endian machine, and vice versa).

CSv

Comma-separated values. Each record is written to one line in the file. By default, a
header is not written. The default character which is used to separate the data fields is
a semicolon (;).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Header
When set to "ON", a header with the Natural field names is written to the file.

Separator character
You can select a different separator character. If you require a separator character
which is not listed in the drop-down list box, you can enter it in the text box of the
drop-down list box.

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.
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Note: The browse button next to this drop-down list box is only available for specific

work file types. See the information in the above table.

For information on the work file formats which result from a specific work file type, see Work
File Formats in the Operations documentation.

Close mode

You can select a different close mode for each work file. Possible values in the drop-down list

box are:

Close Mode

Description

Auto

This is the default setting. Work files are automatically closed at the end of a program or
when the execution of the first called method in a method call hierarchy is terminated and
the first called method was called over COM.

If the first called method was called locally (not over COM), the work files are not closed.

Example: Method A (called over COM) invokes method B which in turn invokes method
C. When the execution of method A is terminated, all work files are closed.

User

Closing of work files is controlled by the user. The work file is closed, if one of the following
conditions is met:

" 2 CLOSE WORK FILE statement is executed,
= a DEFINE WORK FILE statement is executed,

= the session terminates.

The following program example describes the user-controlled closing of work files. Note that
the close mode must be first set in the parameter file.

DEFINE DATA

LOCAL
1 fOUT

(A8)

END-DEFINE

*

J#IOUT := *PROGRAM

*

* Write to work file with close mode "user'

WRITE WORK 1 'OUTPUT PROGRAM: ' #0UT

*

* Write to work file with close mode "auto

WRITE WORK 2 'OUTPUT PROGRAM: ' #QUT

*

* Close work file 1
* Work file 1 is user-controlled
CLOSE WORK FILE 1

*

END
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Attributes
You can define different attributes for each work file. You can specify one attribute for each
of the following categories:

close

Category Possible Default Description
Attributes Attribute
Append mode |[NOAPPEND or [NOAPPEND [Decides whether new data overwrites the current data in the
APPEND work file or whether new data is appended at the end of the
current data.
Keep/delete |KEEP or KEEP Decides whether the work file is kept after closing it or
work file after |DELETE whether it is deleted.

Write byte
order mark
(BOM)

BOM or NOBOM

NOBOM

Decides whether a byte order mark is written in front of the
work file data.

Only available for the work file types which write code page
data: ASCII, ASCII compressed, Unformatted and CSV. For
these work file types, the attribute BOM can only be set, if the
code page UTEF-8 is defined for the work file (see the
description of the Type column).

If a work file of another type is written or a code page other
than UTF-8 is defined, the specification of the attribute BOM
is ignored during runtime.

See also Work Files and Print Files on Windows, UNIX and
OpenVMS Platforms in the Unicode and Code Page Support
documentation.

Remove/keep
carriage return

REMOVECR or
KEEPCR

REMOVECR

Decides whether carriage return characters are removed
when reading an ASCII work file or whether they are kept.

Only available for the following work file types: ASCII and
ASCII compressed. If one of the attributes is manually set
for another work file type (not in the dialog box), it is ignored
during runtime.

Caution: Use KEEPCR with care. ASCII format is only

recommended for alphanumeric data. Binary data should
not be processed with ASCII work files. When you use
KEEPCR, the work file record may include carriage return
characters.

The use of KEEPCR only makes sense when reading ASCII
work files which have been written on UNIX or OpenVMS.
It does not make sense to use KEEPCR with ASCII work files
which have been written on Windows.
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When you choose the browse button next to this text box, you can set these attributes in a
dialog box. You can also set them in the table as described below.

You can enter a unique abbreviation for each attribute. The delimiter character can be one of
the following: blank, comma(,) or semicolon (;). Example: "a, d" which stands for APPEND and

DELETE.

You can only specify one attribute for each category. You can specify them in any sequence.
When no attributes are specified in the table, the default values are used. You can also check
the current values by invoking the dialog box.

Name

Specify the location (path and name) of the work file.

You can also choose the browse button next to this text box to select the work file from a dialog

box.

See also Defining Work File Names with Environment Variables in the Operations documentation.

Natural Development Environment

This parameter group contains the following categories:

= Compiler Options
= Editor Options

Compiler Options

The following profile parameters are used to set options for the Natural compiler.

Option See the Parameter Reference for a description of this profile
parameter
Interpretation of database field short names DBSHORT
Dump generation DU
Length/format specification FS
Keyword checking KCHECK
Structured mode SM
Syntax error control SYNERR
Dynamic thousands separator THSEP
Translate quotation marks TOMARK
MASK compatible with MOVE EDITED MASKCME
Maximum number of digits after decimal point [MAXPREC
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Option

See the Parameter Reference for a description of this profile
parameter

Parameter checking for CALLNAT statement PCHECK

Internal sign representation of format P PSIGNF
Endian mode ENDIAN
Generation of global format identifiers GFID
Active cross reference XREF

See also Compiler Options in the section Using Session Parameters of the Using Natural Studio docu-
mentation and the description of the system command COMPOPT.

Editor Options

The following profile parameter is used to set an option for the Natural editor.

Option

See the Parameter Reference for a description of this profile parameter

Renumber line numbers in constants

RNCONST

Product Configuration

This parameter group contains the following categories:

= Entire System Server
= Web I/O Interface

Entire System Server

The following profile parameter is used in conjunction with Software AG's Entire System Server

Interface.

Option

See the Parameter Reference for a description of this profile parameter

ESX database |ESXDB
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Web /0 Interface

The following profile parameter is used for Unicode support with the Natural Web I/O Interface.

Option
. See the Parameter Reference for a description of this profile parameter

Web I/O Interface [WEBIO

Client/Server

This parameter group contains the following categories:

= DCOM

= HTTP Parameters

= Remote Dictionary Access
= Remote Procedure Call

DCOM

The following profile parameters are used to provide DCOM support.

Option
P See the Parameter Reference for a description of this profile parameter
Server name COMSERVERID
Activation policy ACTPOLICY
Automatic update of registry AUTOREGISTER

HTTP Parameters

The following profile parameter is used to provide HTTP support.

Option
. See the Parameter Reference for a description of this profile parameter

Timeout for REQUEST DOCUMENT |RQTOUT
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Remote Dictionary Access

The following profile parameters are used for remote dictionary access.

Option
. See the Parameter Reference for a description of this profile parameter

Name of logical dictionary server|USEDIC

When a logical dictionary server has been defined in the global
configuration file, you can select it from the drop-down list box. See
Dictionary Server Assignments in the global configuration file.

Enable usage of repository USEREP

Remote Procedure Call

The profile parameters which apply to the Natural Remote Procedure Call (RPC) are arranged on
the following pages:

= RPC (General)
= RPC (Client)
= RPC (Server)
= RPC (RDS)

RPC (General)

These profile parameters apply to both client and server.

Option
: See the Parameter Reference for a description of this profile parameter

Request buffer size [MAXBUFF
Code page CPRPC

RPC (Client)

These profile parameters apply to the client only.

Opti
pon See the Parameter Reference for a description of this profile parameter

Automated remote execution AUTORPC

Retry service on alternative server| TRYALT

Send-buffer compression COMPR
Request timeout TIMEOUT
Default server DFS
Library for service directory RPCSDIR
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RPC (Server)

These profile parameters apply to the server only.

Option
P See the Parameter Reference for a description of this profile parameter

Start session as RPC server SERVER

Logon required for server request|LOGONRQ

Server name SRVNAME
Server node SRVNODE
Server user ID SRVUSER
Server wait time SRVWAIT

Number of reconnect attempts SRVRTRY

Wait time between attempts

Server termination event SRVTERM
Server commit time SRVCMIT
Transport protocol TRANSP
Trace level TRACE

Trace on error

RPC (RDS)

This profile parameter applies to the client only.

Opti
pren See the Parameter Reference for a description of this profile parameter

Remote directory servers|RDS

Tools

This parameter group contains the following categories:

= Debugger
= Profiler
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= Code Coverage

Debugger

The profile parameters which affect the Natural Debugger are arranged in the following categories:

= Compiler Options
= Debug Attach Settings

Compiler Options

This profile parameter is used to generate debug information.

Option
. See the Parameter Reference for a description of this profile parameter

Generate debug information|GPGEN/DEBUGGER

Debug Attach Settings

The following profile parameter is used in conjunction with NaturalONE.

Opti
pron See the Parameter Reference for a description of this profile parameter

Debug attach server parameters|DBGAT

See also the information on debugging external Natural applications in
the NaturalONE documentation.

Profiler

The parameters which affect the Natural Profiler are arranged in the following categories:

= Compiler Options
= General
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= Events
Compiler Options

The following profile parameter is used to activate the Natural Profiler.

Option
. See the Parameter Reference for a description of this profile parameter

Generate profiler information |GPGEN/PROFILER

General

The following profile parameter is used to profile a Natural session.

Option
Y See the Parameter Reference for a description of this profile parameter

General Natural Profiler parameters |[PROFILER

Events

The following profile parameter specifies which events of a Natural session are profiled.

Option
P See the Parameter Reference for a description of this profile parameter

Natural Profiler event selection parameters |PROFILER(EVENT subparameter)

Code Coverage

The profile parameters which affect the Natural code coverage are arranged in the following cat-
egories:

= Compiler Options
= General

Compiler Options

The following profile parameter is used to allow code coverage.
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Option

See the Parameter Reference for a description of this profile parameter

Generate coverage information

GPGEN/COVERAGE

General

The following profile parameter specifies for which parts of a Natural session the code coverage
information is to be generated.

Option

See the Parameter Reference for a description of this profile parameter

General Natural Coverage parameters|COVERAGE
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7 Invoking Natural with an Alternative Parameter File

By default, Natural Studio and Natural Runtime are invoked with the parameter file NATPARM.
When you have created your own customized parameter file, you can also invoke Natural Studio
and Natural Runtime with this parameter file.

See also Dynamic Assignment of Parameter Values in the Operations documentation.

~ To invoke Natural Studio with an alternative parameter file

m  Create a shortcut on your desktop for starting Natural Studio and invoke the properties of
the shortcut. Then specify the following after natural.exe in the Target text box:
PARM=parameter-file. Example:

"C:\SoftwareAG\Natural\Bin\natural.exe" PARM=myparm

~ To invoke Natural Runtime with an alternative parameter file

= Create a shortcut on your desktop for starting Natural Runtime and invoke the properties of
the shortcut. Then specify the following after naturalr.exe in the Target text box:
PARM=parameter-file. Example:

"C:\SoftwareAG\Natural\Bin\naturalr.exe" PARM=myparm
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